
41 

 

 การผลิตสื่อวิดีทัศนสำหรับบุคลากรสายสนับสนุนเพ่ืองานบริการ 
สำนักวิทยบริการและเทคโนโลยสีารสนเทศ  มหาวิทยาลัยราชภัฏเพชรบุรี 
 

โดย  อ.ศราวฒุิ ดวงเบา 

 

 
 
 

เอกสารประกอบการอบรมพัฒนาบุคลากรสายสนับสนนุ 

 
 

การผลิตสื่อวิดีทัศน 
สำหรับบุคลากรสายสนับสนุนเพื่องานบริการ 

(สวนแนะนำการใชโปรแกรม) 
 
 
 
 
 
 
 
 
 
 
 

 
 

โดย  อาจารยศราวุฒ ิดวงเบา 
สาขาวิชาสารสนเทศศาสตรและบรรณารักษศาสตร 

คณะมนุษยศาสตรและสังคมศาสตร 
มหาวิทยาลัยราชภัฏเพชรบุรี 

 
มกราคม 2564 



42 

 

 การผลิตสื่อวิดีทัศนสำหรับบุคลากรสายสนับสนุนเพ่ืองานบริการ 
สำนักวิทยบริการและเทคโนโลยสีารสนเทศ  มหาวิทยาลัยราชภัฏเพชรบุรี 
 

โดย  อ.ศราวฒุิ ดวงเบา 

 

คำนำ 
 
 เอกสารประกอบการอบรมพัฒนาบุคลากรสายสนับสนุนการผลิตสื่อวิดีทัศนสำหรับบุคลากรสาย

สนับสนุนเพื่องานบริการ (สวนแนะนำการใชโปรแกรม) จัดทำขึ้นเพื่อประกอบการอบรมการผลิตสื่อวิดีทัศน

สำหรับบุคลากรสำนักวิทยบริการและเทคโนโลยีสารสนเทศ มหาวิทยาลัยราชภัฏเพชรบุรี ที่มีเนื้อหาในดาน

เทคนิคการใชโปรแกรมเพ่ือการผลิตสื่อการเรียนการสอน เชน โปรแกรมดานการตัดตอภาพและวิดีโอ ไมวาจะ

เปน OBS Studio, Sony Vegas รวมถึงโปรแกรมการตัดตอเสียง Adobe Audition อันจะเปนประโยชนเพ่ือ

การพัฒนาสื่อรองรับการใหบริการนักศึกษาของมหาวิทยาลัยราชภัฏเพชรบุรี ในการเขาถึงการบริการของ

สำนักวิทยบริการและเทคโนโลยีสารสนเทศ ในชวงสถานการณโควิด-19  

 

อาจารยศราวุฒิ ดวงเบา 

สาขาวิชาสารสนเทศศาสตรและบรรณารักษศาสตร 

คณะมนุษยศาสตรและสังคมศาสตร 

มหาวิทยาลัยราชภัฏเพชรบุร ี

19 มกราคม 2564 

 



39 

 

 การผลิตสื่อวิดีทัศนสำหรับบุคลากรสายสนับสนุนเพ่ืองานบริการ 
สำนักวิทยบริการและเทคโนโลยสีารสนเทศ  มหาวิทยาลัยราชภัฏเพชรบุรี 
 

โดย  อ.ศราวฒุิ ดวงเบา 

 

สารบัญ 

 

เรื่อง                             หนา 

 

โปรแกรมสำหรับบันทึกวิดีโอหนาจอคอมพิวเตอร   ........................................................................... 1 

 1. Application Xbox   .......................................................................................................... 1 

 2. OBS Studio   ..................................................................................................................... 2 

  ขอมูลทั่วไปของโปรแกรม OBS Studio   ......................................................................... 2 

  แนะนำหนาจอโปรแกรม OBS Studio   .......................................................................... 2 

  การใชงานโปรแกรม OBS Studio บันทึกการเรียนการสอน   .......................................... 10 

  การตั้งคาการแสดงผล (Output)    .................................................................................. 11 

  การตั้งคาเสียง  (Audio)   ................................................................................................. 12 

  การตั้งคาวิดีโอ (Video)  ................................................................................................... 12 

  การบันทึกวิดีโอหนาจอคอมพิวเตอร   .............................................................................. 13 

  การเริ่มการอัดวิดีโอหนาจอคอมพิวเตอร    ...................................................................... 13 

โปรแกรมสำหรับตัดตอเสียง Adobe Audition  ............................................................................... 14 

 โปรแกรม Adobe Audition   ................................................................................................. 14 

  การใชงานโปรแกรม    ..................................................................................................... 15 

  การสรางไฟลงานใหม   ..................................................................................................... 15 

  การตั้งคาการบันทึกเสียง (ไมโครโฟน)  ............................................................................. 16 

  การนำไฟลเสียงเขาสูโปรแกรม   ....................................................................................... 17 

  การบันทึกเสียงจากไมโครโฟน   ........................................................................................ 17 

  การปรับระดับเสียงใหเทากัน    ........................................................................................ 18 

  การรวมไฟลเสียงสองไฟลระหวางเสียงพูดและเสียงดนตร ี  ............................................. 20 

  การลดระดับเสียงเพลงในขณะที่เสียงพูดกำลังบรรยาย  ................................................... 21 

  บันทึกไฟลเปน .mp3 ....................................................................................................  23 

โปรแกรมสำหรับตัดตอวิดีโอ    .......................................................................................................... 24 

 โปรแกรม Sony Vegas   ......................................................................................................... 24 

  สวนประกอบตาง ๆ ในตัวโปรแกรม Sony Vegas  .......................................................... 24 

  การสรางไฟลงาน   ............................................................................................................ 25 

  กำหนดโปรเจคงาน  ............................................................................................... 27 

  การนำไฟลวิดีโอเขา  ......................................................................................................... 27 

  การตัดตอและใสเทคนิคพิเศษสำหรับวิดีโอ   .................................................................... 28 



40 

 

 การผลิตสื่อวิดีทัศนสำหรับบุคลากรสายสนับสนุนเพ่ืองานบริการ 
สำนักวิทยบริการและเทคโนโลยสีารสนเทศ  มหาวิทยาลัยราชภัฏเพชรบุรี 
 

โดย  อ.ศราวฒุิ ดวงเบา 

 

สารบัญ (ตอ)  

 

เรื่อง                             หนา 

 

  การตัดแบงวิดีโอ   ............................................................................................................. 28 

  การยอ-ขยายและเลือกพ้ืนที่บางสวนของวิดีโอ (Zoom In / Zoom out) ................... 29 

  การ Fade In และ Fade Out วิดีโอ   ............................................................................. 32 

  การสรางเอฟเฟคเทคนิคพิเศษเพ่ือการตอเนื่องของวิดีโอ  ................................................ 32 

  การปรับความสวางของวิดีโอ   ......................................................................................... 34 

  การใสขอความและการจัดวางขอความ  ........................................................................... 35 

  การบันทึกวิดีโอฉบับสมบูรณ   .......................................................................................... 36 

 

 

    

  



1 

 

 การผลิตสื่อวิดีทัศนสำหรับบุคลากรสายสนับสนุนเพ่ืองานบริการ 
สำนักวิทยบริการและเทคโนโลยสีารสนเทศ  มหาวิทยาลัยราชภัฏเพชรบุรี 
 

โดย  อ.ศราวฒุิ ดวงเบา 

 

การผลิตสื่อวิดีทัศนสำหรับบุคลากรสายงานบริการ (สวนของโปรแกรม) 

 

โปแกรมสำหรับบันทึกวิดีโอหนาจอคอมพิวเตอร 

 1. Application Xbox 

   ขั้นตอนนี้ไดรับการนำเสนอขอมูลโดย ฝายบริการความรูทางวิทยาศาสตรและเทคโนโลยี 

(2563)  ซึ่งนำเสนอขั้นตอนการบันทึกวิดีโอหนาจอคอมพิวเตอรที่ใชระบบปฏิบัติการ Windows 10 ขึ้นไป 

ที ่มาพรอมกับโปรแกรม built-in video capture tool ที ่ใชความสามารถของ Application Xbox โดยมี

ขั้นตอนดังนี ้

    1. ผูใชงานตองทำการอนุญาต stream Xbox One games กอน (กรณทีี่เปดใชงานครั้ง

แรก)  

    2. เปดโปรแกรมหรือหนาจอที่เราตองการบันทึกวิดีโอหนาจอคอมพิวเตอร หากทานไม

เปดโปรแกรมหรือหนาจาที่ตองการอดัจะไมปรากฏปุมบันทึกวิดีโอในโปรแกรม 

    3. กด ปุม Windows + G บนคียบอรด 

    4. จะปรากฎหนาจอคำถาม Do you want to open Game bar? ใหกดปุมเพื่อยอมรับ 

“Yes, this is a game” 

 

 
 

    5. หลังจากนั้นแผงควบคุมการเปดปดเพื่อบันทึกวิดีโอหนาจอคอมพิวเตอรจะปรากฎขึ้น

เปน popup บนหนาจอ เรียกวา Game Bar 

 
 

    6. ทำการกดบันทึกวิดีโอหนาจอคอมพิวเตอร 
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     6.1 กดปุ มกลองถายรูป หรือทางลัด Win + Alt + PrtScn สำหรับการถายภาพ

หนาจอ 

     6.2 กดปุมวงกลมสีแดง หรือปุมทางลัด Win + Alt + R สำหรับการบันทึกหนาจอเปน

วีดีโอ และสามารถกด Win + Alt + R เพ่ือหยุดการบันทึก 

    7. ไฟลท่ีบันทึกเปนวิดีโอแลว สามารถไปดูไดในโฟลเดอร Videos > Captures 

 

 2.  OBS Studio 

   ขั้นตอนนี้ไดรับการนำเสนอขอมูลโดย กองเทคโนโลยีสารสนเทศ มหาวิทยาลัยมหิดล (2563) 

ซึ่งนำเสนอรายละเอียดการใชงานเบื้องตนของโปรแกรม OBS Studio ดังหัวขอและขั้นตอนตาง ๆ ดังนี ้

    1. โปรแกรม OBS Studio 

     โปรแกรม OBS Studio หรือ Open Broadcaster Software Studio เปนโปรแกรม

รหัสเปด (Open Source) ใชสำหรับถายทอดสด (Live Stream) ในสื่อสังคมออนไลนตาง ๆ และบันทึกวิดโีอ 

(Record) เก็บไวในคอมพิวเตอร ผูใชสามารถดาวนโหลดมาติดตั้งและใชงานไดฟรี สามารถประยุกตใชได

หลากหลาย เชน การสตรีมเกม การอานขาว และการจัดการเรียนการสอนออนไลน (กฤษณพงศ เลิศบำรุงชัย, 

2563)    

    2. ความสามารถของโปรแกรม OBS Studio 

     2.1 ความสามารถท่ัวไป 

  2.1.1 สรางสตูดอโอจำลองสำหรับการทำงานได 

  2.1.2 สรางหองเรียนจำลองสำหรับการเรียนการสอนได 

  2.1.3 สรางฉากไดหลากหลายรูปแบบและสามารถสลับฉากไปมาได 

  2.1.4 สามารถนำแหลงขอมูลตาง ๆ เขามาใชกับโปรแกรม OBS Studio ได 

  2.1.5 สามารถถายทอดสดบนสื่อสังคมออนไลนไดหลากหลาย 

  2.1.6 สามารถบันทึกวิดีโอดูยอนหลังได 

 2.2  ความสามารถประกอบการเรียนการสอน 

      การใชงาน OBS Studio ในการบันทึกวิดีโอประกอบการเรียนการสอนเปนรูปแบบ

การใชงานโดยผูสอนเปนผูดําเนินการบรรยายและบันทึกวิดีโอดวยตนเองโดยมีการใชงานอุปกรณคอมพิวเตอร 

อาทิเชน กลองสำหรับคอมพิวเตอรหรือกลอง DSLR และไมโครโฟนที่ใชงานในการบันทึกวิดีโอ (กองเทคโนโลยี

สารสนเทศ, 2563) 

    3. แนะนำหนาจอโปรแกรม OBS Studio 

     3.1 หนาจอโปรแกรม OBS Studio แบงออกเปน 3 สวน ไดแก แถบเมนูคำสั่ง

โปรแกรม แถบแสดงผล และแถบควบคุมการดำเนินการแสดงผล 
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      3.1.1 แถบเมนูคำสั่งโปรแกรม 

       3.1.1.1 เมน ูFile 

 
    

    3.1.1.2 เมน ูEdit  

 

3.1.1 3.1.2 

3.1.3 
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       3.1.1.3 เมน ูView 

 
 

       3.1.1.4 เมนู Scene Collection 
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       3.1.1.5 เมนู Tools 

 
 

       3.1.1.6 เมนู Help 

 
 

3.1.2 แถบแสดงผล 

 3.1.2.1 เมนู Transition  
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 3.1.2.2 เมนู Quick Transitions 

 
 

3.1.3 แถบควบคุมการดำเนินการแสดงผล 

 
 

       3.1.3.1 เมนู Scenes 
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       3.1.3.2 เมนู Sources 

 
 

        คำสั่ง Add ในเมนู Sources 
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       3.1.3.2 เมน ูMixer 
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       3.1.3.3 เมน ูScene Transitions 

 

 
 

       3.1.3.4 เมน ูControls 
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        1. เมนู Setting  

 
 

 
 

    4. การใชงานโปรแกรม OBS Studio บันทึกการเรียนการสอน 

     4.1 เปดเครื่องคอมพิวเตอรสําหรับการใชงานโปรแกรม OBS Studio 

     4.2 คลิกที่เมนู Profile > New จะปรากฏหนาตาง Add Profile ขึ้นมา ใหพิมพชื่อที่

ตองการใชงาน จากนั้นคลิกปุม OK 
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     4.3 จากนั้นคลิกที่เมนู Scene Collection > New จะปรากฏหนาตาง Add Scene 

Collection ขึ้นมา ใหพิมพชื่อที่ตองการใชงาน จากนั้นคลิกปุม OK  

                         
 

     4.4 คลิกที่เมนู File > Settings จะปรากฏหนาตาง Settings ขึ้นมา 
 

 
 

 

 

 

 

 

 

     4.5 ใหดำเนินการตั้งคาตาง ๆ ดังนี ้

       4.5.1 เครื่องมือ Output (การแสดงผล) ตั้งคาดังนี้ 

        4.5.1.1 เลือก Output Mode > Simple 

        4.5.1.2 เลือกหัวขอ Recording 

         1. Recording Path > สามารถคลิกเลือกพื้นที่จัดเก็บไฟลวิดีโอไดวา

ตองการใหบันทึกไฟลที่อัดแลวจะบันทึกไวที่ไหนในคอมพิวเตอร   

         2. Recording Quality (เปนการเลือกคุณภาพของการอัดไฟลวิดีโอ) > 

High Quality หรือ Medium File Size 

         3. Recording Format > (เปนการเลือกประเภทไฟลเมื่ออัดเสร็จแลว

ใหบันทึกในรูปแบบไฟลชนิดใด) ใหเลือก mp4 

 



12 

 

 การผลิตสื่อวิดีทัศนสำหรับบุคลากรสายสนับสนุนเพ่ืองานบริการ 
สำนักวิทยบริการและเทคโนโลยสีารสนเทศ  มหาวิทยาลัยราชภัฏเพชรบุรี 
 

โดย  อ.ศราวฒุิ ดวงเบา 

 

 
 

       4.5.2 เครื่องมือ Audio (การตั้งคาเสียง) ตั้งคาดังนี้ 

        เลือกเมนู Mic/Auxiliary Audio Device คลิกแถบขอความเลือก Device 

ของ Desktop Microphone 

 
 

       4.5.3 เครื่องมือ Video ตั้งคาดังนี ้

        4.5.3.1  Base (Canvas) Resolution   1280 x 720 

        4.5.3.2 Output (Scaled) Resolution   1280 x 720 

        4.5.3.3 Downscale Filter      Bicubic 

        4.5.3.4 common fps value     30 

        เมื่อตั้งคาครบทุกเครื่องมือการใชงานแลวใหคลิกที่ปุม OK 
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    5. การบันทึกวิดีโอหนาจอคอมพิวเตอร  

     5.1 ไปที่เครื่องมือ Scenes ใหคลิกที่ปุม Add หรือเครื่อหมาย + จะปรากฏหนาตาง 

Add Scene แลวตั้งชื่อเปน ภาพหนาจอคอมพิวเตอร  

               
 

     5.2 จากนั้นไปที่เครื่องมือ Sources ใหคลิกที่ปุม Add หรือเครื่องหมาย + เลือกเมนู 

Display Capture จะปรากฏหนาตาง Create/Select Source  

     5.3 ชอง Create New ใหพิมพคําวา ภาพหนาจอ แลวคลิกที ่ปุ ม OK จะปรากฏ 

หนาตาง Properties for ภาพหนาจอ พรอมแสดงภาพหนาจอคอมพิวเตอร ณ ขณะนั้นขึ้นมาจากนั้นใหปุม 

OK 

 
 

    6. การเริ่มการอัดวิดีโอหนาจอคอมพิวเตอร 

     6.1 เมื่อพรอมบันทึกวิดีโอการสอน ผูสอนนั่งประจําที่แลวที่โปรแกรม OBS คลิกท่ี 

Scenes กลองผูสอน พิธีกรปรับมุมกลองใหสวยงาม แลวปรับตําแหนงของ Sources ชื่อผูสอน ใหเหมาะสม 

จากนั้นใหผูสอนทดสอบเสียงโดยสังเกตที่เครื่องมือ Mixer จะปรากฏแถบเสียงตามจังหวะการพูด  

     6.2 เมื่อผูสอนพรอมที่จะบันทึกวิดีโอแลว คลิกที่ Scenes ที่ตองการ จากนั้นใหคลิกที่

ปุม Start Recording เริ่มตนบันทึกวิดีโอการสอน 
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       6.3 เมื่อจบการสาธิตการใชงานโปรแกรมเรียบรอยแลว ใหคลิกที่ Scenes กลองผูสอน 

เพื่อทําการสรุปเนื้อหาที่ไดบรรยายไป ทั้งหมด เมื่อสิ้นสุดการสอนใหคลิกที่ปุม Stop Recording เปนการจบ

ขั้นตอนการบันทึกวิดีโอประกอบการเรียนการสอน 

 
 

โปรแกรมสำหรับตัดตอเสียง Adobe Audition 

 

 1. โปรแกรม Adobe Audition 

     Adobe Audition เปนโปรแกรมที่ถูกพัฒนาใหนำมาใชงานในดานของเสียง หรือออดิโอ อาทิ

เชน การอัดเสียง การตัดตอเสียง การแกไขเสียง เพิ่มเสียงหนัก เสียงเบา หรือเอฟเฟคตาง ๆ ในการใชงาน 

สำหรับโปรแกรม Adobe Audition ซึ่งอยูในตระกูลเดียวกับ Adobe Premiere Pro หรือ โปรแกรม Adobe 

After Effects ทาง Adobe ไดพัฒนาออกมาใหมในตอนนี้นั้นเอง  

    2. หนาจอโปรแกรม 

     หนาจอการทำงานหลักของโปรแกรม 

  
 

      2.2.1 แถบเมนูคำสั่งของโปรแกรม  

      2.2.2 แถบแสดงไฟลงาน 

      2.2.3  แถบระดับควบคุมการบันทึกเสียง 

2.2.1 

2.2.2 

2.2.3 
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    3. การใชงานโปรแกรม 

     3.1 การสรางไฟลงานใหม 

      3.1.1 ทุกครั้งกอนเริ่มงานใหสรางงานเพ่ือรองรับไฟลเสียงใหมทุกครั้ง  

      3.1.2 เลือกที่ แถบเมนูคำสั่ง File > New > Audio Flie  

 
 

      3.1.3 ตั้งรายละเอียดเก่ียวกับไฟล ดังนี ้

      

             1. Flie Name ตั้งชื่องานท่ีกำหนดไว 

             2. Sample Rate กำหนดใหขนาด 48000 Hz 

             3. Channels  กำหนดเปนรูปแบบ Stereo 

             4. Bit Depth กำหนดเปน 32(float) bits 

 

      เมื่อกำหนดการตั้งคาไฟลใหมแลวจะปรากฏหนาจอโปรแกรมที่พรอมทำงาน 
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     3.2 การตั้งคาการบันทึกเสียง (ไมโครโฟน) 

      3.2.1 เลือกที่ แถบเมนูคำสั่ง Edit > Preferences > Audio Hardware   

 
 

      3.2.1 เลือกที่ แถบเมนูคำสั่ง Edit > Preferences > Audio Hardware   

      3.2.2 โดยดูที ่ห ัวขอ Default Input  (ชองสัญญาณที ่นำเขาเสียงไมโครโฟน) หรือ 

Default output (ชองสัญญาณที่นำเสียงออกแสดงผล) โดยการดูคำสั่งเหลานี้เปนการปรับแตงคาไมโครโฟน

และลำโพง ***หากไมมีเสียงออกหูฟง/ลำโพง หรือเวลากดอัดแลวไมมีเสียงอัด ใหมาตรวจสอบการตั้งคาสวนนี้

ดวยทุกครั้ง โดยเลือกชองเขา-ออกสัญญาณใหตรงกับอุปกรณของเราที่ใชงานจริง 
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     3.3 การนำไฟลเสียงเขาสูโปรแกรม 

      3.1.1 เปดโฟลเดอรที่เก็บไฟลเสียงไว (ไฟลเสียงท่ีนำลงควรแปลงเปนไฟล mp3) 

      3.1.2 ลากไฟลเสียงที่ตองการลงในแถบแสดงผลการปรับระดับเสียง 

       
 

      3.1.3 สามารถใชเมนูควบคุมการเลนเสียงไดจากดานลาง 

 
 

       1.  ปุมหยุดการบันทึก/เลนเสียง (หยุดและไปตั้งสถานะการเลนเสียงใหม) 

       2. ปุมเลนเสียง 

       3.  ปุมหยุดชั่วคราว (หยุดระหวางเลนในชวงนั้น ๆ) 

4.  ปุมยอนหลังไปจุดเริ่มตน 

       5.  ปุมเลนยอนหลังทีละครั้ง 

       6.  ปุมขามไปดานหนาทีละครั้ง 

8.  ปุมขามไปขางหนาสุด 

9.  ปุมบันทึกเสียง 

10.  ปุมใหเลนวนซ้ำ 

11.  ปุมเลนถัดไปตามที่กำหนด 

 

     3.4 การบันทึกเสียงจากไมโครโฟน 

      3.4.1 การสรางไฟลงานใหม ตามขอ 3.1 

      3.4.2 กดคลิกที่แถบแสดงระดับเสียง 1 ครั้ง เพ่ือใหเกิดระดับเสียงแถบสีเขียวข้ึน 
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      3.4.3 กดปุมบันทึกเสียง  จะปรากฏเสียงท่ีเราพูดลงไป เมื่อพูดเสร็จดังที่ตองการแลว

ใหกดปุม  ปุมหยุดการบันทึก/เลนเสียง พรอมดวย Save งานใหเรียบรอย 

 
 

      3.4.5 การปรับระดับเสียงใหเทากัน 

       1. กด ctrl + A ที่ชอบแถบแสดงขอมูลเสียง จะปรากฏแถบสีขาวคลอบคลุม หรือ

ตองการใหแคสวนใดจะปรับใหลากเมาสเลือกเฉพาะสวนก็ได 
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       2. เลือกที่แถบเมนูคำสั่งดานบนที่ Effects > Amplitude and Compression > 

Hard Limiter… 

 

 

 

 

 

 

 

 

 

       3. จะปรากฏกลองเครื่องมือ ใหปรับแตงเฉพาะหัวขอ Presents เลือก Limit to -3dB 

และกด Apply จะปรากฎแถบเสียงท่ีสม่ำเสมอกัน 

   
 

      3.4.4 การบันทึกงาน 

       1. เลือกเมนูดานบน File > Save as 

 
 

       2. กำหนดการตั้งคาดังนี้ 

        2.1 File Name  ใหตั้งชื่อไฟลงานตัวเอง 

        2.2 Location เลือกโฟลเดอรสถานที่จัดเก็บไฟลงาน 
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        2.3 Format เลือกประเภทไฟลงานที่ตองการใหบันทึก ในท่ีนี้เลือก mp3 

        2.4 กด OK 

 
 

        2.5 จะปรากฏกลองขอความการยืนยันการเปลี่ยนแปลงไฟล ใหกด Yes 

 
 

     3.5 การรวมไฟลเสียงสองไฟลระหวางเสียงพูดและเสียงดนตร ี

      3.5.1 เล ือกเมนูคำสั ่งด านลางแถบเมนูคำสั ่งหลัก โดยเลือกเมนู Multitrack การ

ผสมผสานหลากหลายเสียง (ไมตองสรางไฟลงานใหมตามขอ 3.1) 

 
 

      3.5.2 จะปรากฏกลองขอความ New Multitrack Session โดยเบื ้องตนเราได ตั้ง

คุณสมบัติของ Sample Rate, Bit Depth, Master ไวแลว ไมจำเปนตองปรับอีก สิ่งที ่เราจะตองปรับคือ 

Session Name ใหสอดคลองกับชื่อที่เราตั้งกอนหนานั้น และกด OK 



21 

 

 การผลิตสื่อวิดีทัศนสำหรับบุคลากรสายสนับสนุนเพ่ืองานบริการ 
สำนักวิทยบริการและเทคโนโลยสีารสนเทศ  มหาวิทยาลัยราชภัฏเพชรบุรี 
 

โดย  อ.ศราวฒุิ ดวงเบา 

 

 
 

      3.5.3 จะปรากฏหนา Multitrack ที่มีจำนวนหลากหลายกลองใหวางไฟลงานเสียง  

      3.5.4 เปดโฟลเดอรไฟลงานเสียงที่ 1 และที่ 2 ขึ้นมา ลาลงพื้นที่ชองวาง โดยใหทั้ง 2 

เสียง อยูตางชางกัน  

 

 

 

 

 

 

 

      3.5.5 การลดระดับเสียงเพลงในขณะที่เสียงพูดกำลังบรรยาย 

       1. เลือกที่ชองที่เปนไฟลเสียงดนตรี 

       2. เลือกเสนสีเลืองออนที่อยูเหนือเสนขั้นกลางดานซายและขวาของเสียง กดคลิกที่เสน

ที่เหลือ 1 ครั้งใหปรากฏจุดเล็ก ๆ เปนจุดที่กำหนดวาจะใหเสียงเริ่มเบาลงตัง้แตตรงนี้  
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       3. กดเลือกจุดหางกันเล็กนอยจะเปนการเวนชองระหวางจุดเริ่มตนการกำหนดใหเสียง

มีการลดลง เมื่อกดสรางอีกจุดใหลากเสนลงมาไดในระดับพอเหมาะกับการลดเสียงลงใหสอดคลองกับเสียงพูด

ทั้งนี้ตองเปดเลนเสียงไปเพื่อฟงความพอดีดวย  

 
 

       4. เมื่อใกลสิ้นสุดการพูดของผูบรรยาย ใหทำแบบเดียวกันคือจุดที่เสนสีเหลืองระดับ

โทนเสียงของเสียงเพลงใหใกลเคียงกับเสียงบรรยาย แตจุดตัวสุดทายจะตองลากขึ้นมาใหเทาระดับจุดแรกสุดที่

กำหนดเปนจุดเริ่มตนเสียง ใหสังเกตดูคาระดับของเสียงเวลาลากจุดขึ้นลง 

 
 

       5. การปรับระดับเสียงทั้งหมดใหมีความดัง มีความเบา สามารถทำไดที่จุดหมุนปรับ

เสียงของเมนูควบคุมดานซายของตัวโปรแกรม 
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       6. การรวมไฟลงาน กด Ctrl + A ของหนาไฟลงาน  

         
 

       7. คล ิกขวาท ี ่พ ื ้นที ่ว างส ีเทา เล ือก Mixdown Session to New File > Entire 

Session และรอจนไฟลสมบูรณจะเดงกลับมาหนา Wavefrom 

  
 

       8. ทดลองฟง  

       9. บันทึกไฟลเปน mp3 

        9.1 เลือกเมนูดานบน File > Save as 

 
 

        9.2 กำหนดการตั้งคาดังนี้ 

         9.2.1 File Name ใหตั้งชื่อไฟลงานตัวเอง 

         9.2.2 Location เลือกโฟลเดอรสถานที่จัดเก็บไฟลงาน 

         9.2.3 Format เลือกประเภทไฟลงานที่ตองการใหบันทึก ในที่นี้เลือก mp3 
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         9.2.4 กด OK 

         9.2.5 จะปรากฏกลองขอความการยืนยันการเปลี่ยนแปลงไฟล ใหกด Yes 

 

 

 

 

 

 

 

 

โปรแกรมสำหรับตัดตอวิดีโอ Sony Vegas  

  

   1. โปรแกรม Sony Vegas  

    โปรแกรม Sony Vegas เปนโปรแกรมตัดตอวิดีโอบนระบบปฏิบัติการ Windows ที่ถูกพัฒนามา

เพ่ืองานตัดตอวิดีโอและเสียง โปรแกรมนี้รองรับและสนับสนุนไฟลหลากหลายรูปแบบที่เปนวิดีโอ ไมวาจะเปน

WMV, AVI, MP4, MOV เปนตน  

               Sony Vegas เปนโปรแกรมที่มีการใชงานงาย แตมีฟงกชั่นและเทคนิคพิเศษที่ซอนอยูภายในตัว

โปรแกรมมากพอที่สามารถประยุกตใชไดหลากหลาย แตกตางจากโปรแกรมทั่วไปที่ทำไดนอยกวาและไม

ยืดหยุนในการใชงาน ดวยการทำงานแบบชั้น (Layer)คลายๆกับโปรแกรม Photoshop และมี Effect และ 

Transition อยางหลากหลายท่ีเปนแบบสำเร็จรูป จึงสามารถใชงานไดอยางเขาใจไดงาย สามารถในการตัดตอ

ภาพและเสียงไปพรอมกันได แตยังคงการใชเทคนิคดานความคิดสรางสรรคของผูใชโปรแกรมจะใชฟงกชั่น

เทคนิคพิเศษตาง ๆ มาจัดองคประกอบใหมีความหลากหลายในรูปแบบพิเศษอ่ืน ๆ ดวยตัวเอง 

   2. สวนประกอบตาง ๆ ในตัวโปรแกรม Sony Vegas  
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    1. Menu Bar คือ แถบเมนูสำหรับรวบรวมคำสั่งท่ีใชในโปรแกรม 

    2. Tool Bar คือ แถบเครื่องมือที่ใชในการทำงานบอยๆ เชน New,  Open, Save, Cut, Copy 

เปนตน 

    3. Support Windows คือ หนาตางที่ใชสำหรับรวบรวมฟงกชั่นตาง ๆ ของโปรแกรม รวมถึง 

การเขาถึงไฟลในเครื่องคอมพิวเตอรดวย 

    4. Time line คือ สวนที่แสดงผลระยะเวลาในการทำงานของ Cursor 

5. Layer คือ สวนท่ีใชสำหรับแบงชั้นระหวางวีดีโอ เสียง หรือวัตถุอ่ืน ๆ แยกเปนชั้นๆ ไป 

    6. Preview Windows คือ หนาตางสำหรับแสดงผลวีดีโอที่เรากำลังดำเนินการตัดตอ 

7. Mixer คือ สวนที่ใชสำหรับปรับระดับเสียงใหกับงาน 

    8. Control Bar คือ สวนที่ใชสำหรับควบคุมการทำงานของโปรเจค เชน เลน หยุด พัก หรือ 

บันทึก เปนตน 

    9. Status Bar คือ แถบแสดงขอมูลวาเราสามารถเก็บขอมูลไดอีกกี่นาที ในเครื่องของเรา 

 

   3. การสรางไฟลงาน 

    3.1 การกำหนดขนาดงานเบ้ืองตน  

     การกำหนดขนาดวิดีโอสำหรับจัดทำเพื ่อเผยแพรผานสังคมออนไลนแบงประเภทตามสื่อ 

ตาง ๆ ดังนี้  

      1. Facebook  

       1.1 ขนาด 820 x 312 pixel เหมาะสมหรับเปนวิดีโอที ่ภาพหนาปก Facebook 

(Cover Page Video) ควรมีเวลาวิดีโอไมเกิน 20-90 วินาที  

       1.2 ขนาด 1280 x 720 pixel เหมาะสำหรับเผยแพรเปนวิดีโอทั่วไป (ADS Video) 

ควรมีเวลาวิดีโอไมเกิน 240 นาที  

       1.3 ขนาด 1080 x 1920 pixel เหมาะสำหรับเผยแพรเปนวิดีโอในรูปแบบการสราง

เนื้อหาเพ่ือการโฆษณา (Story) ควรมีเวลาวิดีโอไมเกิน 120 นาที  

 

 

 

 

 

 

 

 

 

820 x 312 pixel 
1280 x 720 pixel 

1080 x 1920 pixel 
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      2. Youtube 

       Youtube เปนสื่อหลักที่ใชเผยแพรวิดีโอทุกรูปแบบและทุกขนาด ซึ่งตามการศึกษา

และเก็บขอมูลเบื้องตนพบวา ผูใช Youtube ใชเวลาอยูหนาจอคอมพิวเตอรไมเกิน 40 นาที เพื่อดูเนื้อหาสวน

ตนวานาสนใจอยางไรและควรจะติดตามตอหรือไม ประกอบกับการทำคลิปวิดีโอในสวนมากจะไมนิยมทำเกิน 

40 นาที ตางจากการใช Youtube เขาชมจากสมารทโฟนที่แสดงใหเห็นวาขนาดวิดีโอที่เปนมาตรฐานยังถกูใช

ไปอยางแพรหลาย และยังไดรับความนิยมอยางตอเนื่อง เหมาะสำหรับใชบนจอทีวี จอโรงภาพยนตร หรือ

จอมอนิเตอรเล็ก ๆ ในลักษณะเปนภาพกวางและแนวนอน  

       Youtube มีขนาดวิดีโอที่ใชไดอยางหลากหลายดังนี้ 854×480 pixel / 1280×720 

pixel / 1920×1080 pixel / 2560×1440 pixel และขนาดของไฟลไมควรเกิน 128 GB 

 

 

 

 

 

      3. Instagram  

       วิดีโอของ Instagram เปนขนาดแนวตั้ง นิยมใชผานโทรศัพทมือถือ ดังนั้นวิดีโอของ 

Instagram จึงตอบโจทยในการดูวิดีโอผานโทรศพัทมือถือสำหรับผูใชสมารทโฟนมากที่สุด 

       ขนาดรูปแบบของ Instagram มี 3 ขนาด ไดแก 600×315 pixel / 600×600 pixel 

/600×750 pixel และมขีนาดไฟลไมเกิน 4 GB และความยาวไมเกิน 30-60 วินาที 

 

 

 

 

 

 

 

 

 

 

 

  

1920 x 1080 pixel 
854 x 480 pixel 

1280 x 720 pixel 

600 x 600 

pixel 1920 x 1080 pixel 

1920 x 1080 pixel 
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    3.2 กำหนดโปรเจคงาน 

     3.2.1 เลือกที่แถบ Menu Bar ดานบนสงท่ีคำสั่ง File > New 

 
 

     3.2.2 จะปรากฏกลองการสราง Project ตัวใหม ใหดำเนินการตั้งคา 2 สวน ดังนี้  

  
 

    3.3 การนำไฟลวิดีโอเขา (กรณีนำเสียงเขาก็ใชลักษณะเดียวกัน) 

     3.3.1 เปดโปรแกรม Sony Vegas 

     3.3.2 เปดโฟลเดอรไฟลวิดีโอสำหรับตัดตองานไวดวย 

     3.3.3 ลากไฟลวิดีโอ/ภาพเขามาไวที่ Time Line (ไฟลภาพที่สามารถนำไมใชในการตัดตอ

และยังคงคุณภาพระดับพอใชถึงดี ไดแก MOV, AVI, MP4, WMV รวมถึงไฟลภาพ Jpeg, png) 

 

หัวขอ Template 

 ใหเลือก HD 1080-60i 

 (1920x1080, 29.970 fps) 

หัวขอ Full-resolution rendering quality 

 - ใหเลือก Best 

 - กด OK 
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   4. การตัดตอและใสเทคนิคพิเศษสำหรับวิดีโอ 

    4.1 การตัดแบงวิดีโอ 

     4.1.1 ใชเมาสวางบนพื้นที่สีเทาของของ Time Line ใหลูกศรเมาสเปนรูป   

     4.1.2 กดเมาสลากในพื้นที่ที่ตองการจะตัดแบงตัววิดีโอ 

 
 

     4.1.3 กดปุม Delete บนคียบอรด วิดีโอจะตัดแบงสวนแยกออกทันที 

 
 

     การตัดแบงสวนวิดีโอดังกลาว เปนการตัดแบงแยกออก แตยังคงเนื้อหาสวนหนาหรือสวนหลัง

ไวเหมือนเดิมสามารถยืดเขายืดออกเพื ่อเรียกเนื้อหาสวนที ่หายออกมาได โดยการนำเมาสวางไวที ่หนา

จุดเริ่มตนของวิดีโอ ใหปรากฏเมาสในรูป     และลากเมาสออกทางดานซายเปนการเรียกเนื้อหาสวนหนา

กลับมา 

จะเห็นวาตัว

โปรแกรมจะแยกการ

ทำงานของวดิีโอและ

เสียงออกจากกัน 

ดังน้ันจึงสามารถลบ

เฉพาะไฟลเสียงหรือ 

วิดีโอก็ได 
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     การกดตัดเนื้อหาดานหนาและดานหลังของสื่อวิดีโอดวยการใชเมาสรูปแบบ    สามารถใช

ในการตัดสวนที่ไมตองการที่อยูเนื้อหาดานหนาไดและดานหลังไดอีกเหมือนกัน 

 

 
 

     เมื่อมีการลากขยายขอบเขต Time Line การเดินเรื่องวิดีโอตอและปรากฏเครื่องหมาย       

ระหวางตัววิดีโอนั้นหมายถึงสิ้นสุดไฟลวิดีโอนี้แลว แตก็จะเริ่มวนใหมตั้งแตตนของวิดีโอตนฉบับ 

 

    4.2 การยอ-ขยายและเลือกพื้นที่บางสวนของวิดีโอ (Zoom In / Zoom out) 

     4.2.1 คลิกเครื่องหมาย     ที่ทายวดิีโอที่จะดำเนินการยอ-ขยายและเลือกพ้ืนที่บางสวนของ

วิดีโอ  
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     4.2.2 จะปรากฏกลองเครื่องมือ Video Event FX  

 
 

     4.2.3 เลือกเครื่องมือ Lock Aspect Ratio เปนการกำหนดใหขนาดของภาพวิดีโอหากยอ

และขยายใหคงเฟรมภาพจอปกติทำใหภาพหนาจอไมตัดสวนใดสวนหนึ่งไปจนเกิดขอบสีดำ เมื่อคลิกแลวให

ลากยอขยายที่มุมของภาพตามพื้นที่ที่ตองการใหยอยขยาย 

 
 

 

ระหวางที่ยอขยายมุมมองของภาพ 

สามารถดูตวัอยางการแสดงผลไดที่ 

หนาจอหลักของ Vegas ไปดวยได 
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     4.2.4 การกำหนดการตั้งแคการเลนวิดีโอสวนที่เลือก ใหยอ-ขยาย ตามการกำหนดเวลาของ

เราเอง โดยการใช Time Line Position ในคำสั่ง Video Event FX โดยใหปฏิบัติตามขั้นตอนดังนี้ 

      1. ตอนนี้ Key time line start เปนสัญลักษณ  เราเริ่มที่ 0:00:00  

       
 

      2. สราง Key time line end เปนสัญลักษณ  ที่เวลา 0:00:21.07 ซึ่งจะลดขนาดกรอบ

ของภาพลงดวยการยายสวนพ้ืนที่ภายในวิดีโอดวยการ zoom ภาพ โดยนำตัวเลน Time Line ไปวางไวที่เวลา 

0:00:20 โดยคลิก 1 ครั้งท่ีเสน Time Line Position สีเทาออน 1 ครั้ง 

  
 

 

 

 

      3. เลือกเครื่องมือ Lock Aspect Ratio และใหลากยอกรอบที่มุมของภาพตามพื้นที่ที่

ตองการให zoom เขา จะปรากฏสัญลักษณ  ที่ Time Line Position ที่เรากำหนดไว เมื่อพอใจกับการ

เลือกพื้นที่แลวใหกดเครื่องหมาย x เพ่ือปดหนาจอนี้ไป และกดเลนไฟลวิดีโอที่หนาจอแสดงผล  

Time Line Position 

Key Time Line Start 

ระยะเวลา Time Line นำเสนอของวิดีโอ

สวนนีม้ีความยาว 21.10 วินาท ี

โดยขณะนี้ภาพที่เริ่มตนคอืภาพเต็มสวน 

เสน Time Line 
1. คลิกที่เสนแถบสีเทา 1 คร้ังที่จุดที่จะ

ใหเลนวิดีโอถึงจุดสุดทาย 

2. ภาพจะเปล่ียนมาเปนภาพสุดทายใน

ตัววิดีโอตัวนั้น 
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    4.3 การ Fade In และ Fade Out วิดีโอ  

      Fade In หมายถึง การคอย ๆ ปรากฏขึ้นมาอยางชา ๆ ของสื่อ 

Fade Out หมายถึง การคอย ๆ หายไปอยางชา ๆ ของสื่อ 

     1. เลือกเครื่องหมาย        ท่ีมุมใดมุมหนึ่งของวิดีโอ จะปรากฏเมาสเปนเครื่องหมาย  

     2. กดลากเมาสเม่ือปรากฏเครื่องหมาย          จะปรากฏเสน Fade In ถาอยูหนาสุดวิดีโอ 

แตถาทำดานหลังจะปรากเสน Fade Out 

     3. สามารถทำกับเสียงไดดวยเหมือนกัน  

 
       

    4.4 การสรางเอฟเฟคเทคนิคพิเศษเพ่ือการตอเนื่องของวิดีโอ 

     4.1.1 การตอเนื่องของวิดีโอรูปแบบพื้นฐานดวยการเปลี่ยนภาพ Smooth Fade 

      1. การทำการตอเนื่องของวิดีโอรูปแบบพื้นฐานดวย Smooth Fade ตองใชวิดีโอตั้งแต 2 

ชิ้นงานขึ้นไป  

      2. ลากวดิีโอชิ้นที่ 2 ที่อยูหลังชิ้นที่ 1 ใหทับซอนกันจะปรากฏเสน Fade ตัดกัน 
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     4.1.2 เทคนิคการเปลี่ยนภาพ 

      1. ดำเนินการตามข้ันตอนขอ 4.1.1  

      2. เมื ่อปรากฏเสน Fade ตัดกันแลว ใหเลือกเมนู Transitions ในพื ้นที ่ Support 

Windows  

 

 

 

 

 

 

 

      3. เลือกรูปแบบ Transitions ตาง ๆ ตามที่ตองการโดยสามารถดูตัวอยางดานขวามือของ

คำสั่งได 

      4. เมื่อเลือกรูปแบบ Transitions แลว ใหลากตัว Effect Transitions ใสระหวางเสน 

Fade ตัดกัน 

 
 

      5. เมื่อลากลงมาไวที่เสน Fade แลวจะปรากฏกลองปรับแตง Transitions ซึ่งสามารถ

ปรับแตงคุณสมบัติตาง ๆ ของ Effect Transitions เม่ือปรับแตงเสร็จแลวใหกด x เพ่ือออกจากกลองปรับแตง

นี้ได เปนอันเสร็จสิ้นการทำ Effect Transitions และสามารถเลนวิดีโอเพื่อดูตัวอยางที่ทำได 

รูปแบบ Transitions ตาง ๆ 

ที่แสดงตัวอยางดานขวามอืของคำส่ัง 

พื้นที่แสดงตัวอยางรูปแบบ Transitions  
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    4.5 การปรับความสวางของวิดีโอ 

     4.5.1 เลือกเมนู Video FX ในพื้นที่ Support Windows  

4.5.2 เลือกเมนู Brightness and Contrast จากเมนู Video FX  

4.5.3 เลือกเมนูยอย Brighter  

     4.5.4 เมื่อเลือกรูปแบบ Video FX ในรูปแบบของ Brighter แลว ใหลากตัว Brighter ใส

วิดีโอที่ตองการปรับแสง 

 
 

 

 
 

1. เลือก Video FX 

2. เลือก Brightness… 

3. เลือก Brighter 

4. ลาก Video FX 

ใสวิดีโอที่ตองการ  
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     4.5.5 เมื ่อลาก Video FX ลงมาไวตัววิดีโอแลวจะปรากฏกลองปรับแตง Video FX ซึ่ง

สามารถปรับแตงคุณสมบัติตาง ๆ ของ Brighter เมื่อปรับแตงเสร็จแลวใหกด x เพื่อออกจากกลองปรับแตงนี้

ได เปนอันเสร็จสิ้นการทำ Effect Transitions และสามารถเลนวิดีโอเพื่อดูตัวอยางที่ทำได 

 
 

     4.5.6 Video FX เปนตัวโปรแกรมสำเร็จรูปที่ชวยสรางเนื้อวิดีโอในรูปแบบตาง ๆ ไมวาจะ

เปนการเลนสีภาพวิดีโอ การปรับความอ่ิมตัว ความเขมของสี ภาพเซนเซอร ภาพตัดโปรงตรงกลาง กรอบภาพ 

สีภาพทีวีแบบสมัยกอน ฯลฯ ผูใชงานสามารถลองใชงานสวนนี้ได 

 

    4.7 การใสขอความและการจัดวางขอความ 

     4.7.1 คลิกขวาตรงพื้นที่วางของพ้ืนที่ Layer โดยคลิกขวาที่ดานลาง แลวเลือก Insert Video 

Track จะปรากฏ Layer Time Line ตัวใหม ข้ึนมาขางบน 

           
 

     4.7.2 คลิกขวาตรงแถบวิดีโอที่สรางขึ้นมา เลือก Insert Text Media  
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     4.7.3 จะปรากฏกลองปรับแตงขอความขึ้นมาสามารถที่จะปรับแตงขอความทั้งสี ขนาด 

รูปแบบตัวหนังสือไดตามที่ตองการ เมื่อตั้งคาเสร็จแลวสามารถกด x เพ่ือออกจากหนาจอตั้งคาได 

 
 

 

    4.8 การบันทึกวิดีโอฉบับสมบูรณ 

     4.8.1 เมื่อจัดทำวิดีโอเสร็จแลว ขั้นตอนตอไปเปนขั้นตอนสุดทายของการ Render Export  

วิดีโอเปนวิดีโอสมบูรณ 

     4.8.2 ใชเมาสวางบนพ้ืนที่สีเทาของของ Time Line ใหลูกศรเมาสเปนรูป   และลากตั้งแต

ตนคลิปจนถึงปลายคลิปสุดทาย ใหเปนแถบสีฟาคลุมคลิปที่เราทำ 

 
 

     4.8.2 เลือกคำสั่งที่แถบ Menu Bar ดานบน และเลือก Render As… 

 
    

  

สีขอความ  (Text color) 

การจัดวางขอความ (Location) 

ตั้งคาขั้นสูง  (Advance) 

เสนขอบ (Outline) 

เงา (Shadow) 

ตัวหนังสือสามารถยอขยายและจัดวางในพื้นที่ที่

ตองการโดยใชทางลดัจากการควบคุมที่หนาจอที่

แสดงได 
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     4.8.3  โดยต้ังคาตามหัวขอตาง ๆ ดังนี ้

      1. Folder   เลือกแหลงจัดเก็บวิดีโอเม่ือ Render เสร็จ 

      2. Name   ตั้งชื่อวิดีโอ (หลีกเลี่ยงการตั้งชื่อยาว) 

      3 .  Output Format เล ือกประเภทการ Render ไฟล   เป นแบบ MainConcept 

AVC/AAC (.mp4, avc)  และเลือก Internet HD 720p (หรือขนาดตามไฟลที่กำหนดตั้งแตสราง) และกด 

Render (การรอ Render ตองใชเวลาพอสมควรขึ้นอยูกับจำนวนวิดีโอ ไฟลตาง ๆ ที่อยูในตัวงานเยอะขนาด

ไหน) 
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